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February MeetingJanuary Meeting
This month's presentation was done 
by our own Bradley Dichter. It fea-
tured the products newly released at 
Macworld Expo.

There were three new things 
announced at the Keynote: iLife ’09, 

iWork ’09 and the 17" MacBook Pro.
Bradley began with the new iLife Suite. He started off 
with iPhoto, which includes the following new features:
■ Faces, which allows you to organize photos by who’s 
in them.
■ Places Organize and explore photos by location. This 
feature uses data from GPS-enabled cameras or the camera 
on iPhone to categorize photos by location and convert 
GPS location tags to common, user-friendly names.
■ Online Sharing: iPhoto ’09 lets you publish photos 
directly to Facebook, or Flickr with just a few clicks.
■ Improved editing features. These include: A new 
checkbox in the saturation slider makes the colors in 
your photos pop without affecting skin tones. The defi-
nition slider improves clarity and brings out detail. The 
retouch brush adds a detect edges feature that prevents 
blurring of detail when you remove spots or blemishes 
over solid edges. Also included is an auto red-eye tool 
works with face detection to remove red-eye with just 
one click.
Next he discussed iMovie ’09, the new features of 
which are as follows:
■ Advanced drag and drop; iMovie ’08 introduced 
drag-and-drop editing. iMovie ’09 takes drag-and-drop 
editing further. Now you can replace or insert clips 
using a single pop-up menu.
■ Video Stabilization: New video stabilization in 
iMovie ’09 analyzes how much your camera was 
moving while you were recording, then automatically 
reduces camera shake.

This month our general meeting 
features a presentation by one of 
LIMac’s board members, Richard 
Hickerson. Using audio data from 
last month’s Q&A session and our 
Macworld Expo wrap-up portion of 
the general meeting, Richard will 
demonstrate how to create a short 

podcast. He’ll be ready to take your 
questions and explain what software he uses and how the fin-
ished podcast gets out to the public. If you’ve ever wanted to get 
your thoughts out to the mass of Mac users, Richard’s demon-
stration will show you how. The meeting will also include our 
regular features: two Q&A sessions, announcements & raffle 
and will be followed by our SIG sessions. 0

FEBRUARY

13

Rick MattesonScott Randell

■ New Titles, Transitions, and Effects, including 
adjustable slow motion.
Also discussed was GarageBand ’09. New fea-
tures include:
■ Basic and Artist lessons on both guitar and piano.
■ New Guitar Features
■ GarageBand ’09 allows you to use amp, and 
stompbox effects that re-create the sound of leg-
endary guitar rigs.
After the iLife summary, Brad went on to present 
the new features in iWork ’09. He started with
Pages. The new features include:
■ Full Screen View: This lets you focus on your work 
without being distracted by items on your desktop. 
If you need to use your tools you simply move your 
cursor to the top of the screen and the tools appear.
■ Dynamic Outline Mode: Allows you to organize 
your thought by creating a detailed outline with 
multiple levels.

January Meeting continued on Page 2
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■ Mail Merge with numbers and Address Book. This has been 
the most requested feature to be added to Pages. works directly 
with a Numbers table or Address Book. In just a few clicks, you 
can merge your contacts or any type of data and easily create 
customized documents.
■ Enhanced Template Chooser:  Easier and faster Template 
choosing. Over 180 Apple-designed templates are included.
■ MathType and EndNote: MathType* allows you to create 
sophisticated equations for use in exams, lab reports, or 
research papers. EndNote* makes it easy to properly site sources 
in academic research papers. *Sold seperatly.
Next Brad described the new features included in Numbers 
’09 which are as follows:
■ One-click formulas. Over 250 functions with built-in help 
are included. Just click and choose one. Use visual placeholders 
for each variable. Explanation of what each formula does is 
included.
■ Formula List view: With the new Formula List view, you can 
see every calculation in your spreadsheet at one time.

General meeting time schedule:
Meetings are held at The New York Institute of 
Technology, Building 300 (Anna Rubin Hall), 
Old Westbury, Long Island.

Meetings start promptly at 7:00 p.m.
Bradley’s Q&A: 7:00 – 7:30 p.m.
MacBasics Q&A: 7:00 – 7:30 p.m. 
For February we will have Mac hard drive cleaning 
with various utilities. We will begin the meeting 
with our MacBasics Q & A.
Featured Presentation: 7:30 – 8:20 p.m. 
followed by announcements and raffle 
drawings.

SIG Meetings: (Special Interest Groups)
DTP/Photoshop SIG 2009: 8:30 – 10:00 p.m. 
The Mac Coloring Book: Create a line drawing from a 
photo and color it again like a kids coloring book.

| In bad weather, call (516) 686-7789.
| �The next LIMac board meeting will be at 

the  
Plainedge Library, (516) 735-4133, on  
Wednesday, February 18th, at 7:45 p.m.  

President’s Message

| I installed Microsoft Office 2008 on 
my new iMac and it doesn’t open PDFs? 

Why wouldn’t it?
■ It is not supposed to open PDF files. It was not programmed 
with that functionality. With a document open, you can Insert 
a Picture from File and specify a PDF file. You can save a docu-
ment as a PDF file and you can print and let the Mac operating 
system save as a PDF, but it can’t open them as such. By default, 
the Mac will open PDF files with Preview. If you also have 
downloaded and installed the free Adobe Reader 9, then that 
could be used to open PDF files.
| I see you’ve installed Mac OS 10.5.6. There is a bug 
which affects Yahoo Mail which wasn’t there in the older 
system. I used to be able to switch between my account 
and my wife’s. I’ve told Yahoo about it and they said they 
would fix it in the next version. Firefox is not affected.
■ Actually the problem may be with Safari 3.2.1, not Mac 
OS 10.5.6. You used to be able to easily switch with a single 
click on a link from one small business account to another and 
now you have to, in the new Safari, log out and log in as the 
other account. It used to redirect and now it doesn’t. It seems 
a recent update of their Business Mail software is at fault and 
Apple’s Mail has a similar problem. Luckily there are alternative 
web browsers not based on WebKit you can use.
| I’ve discovered the equalizer in iTunes and had fun 
exploring the different presets for the various songs in my 
iTunes library. I have some rock and blues and jazz. How can 
I have each folder set up for a specific equalizer setting?
■ You can’t apply an equalizer setting to a playlist, but you can 
apply it to multiple songs at once, so the current contents of 
the playlist can be set to a specific preset. If you add any new 
songs to that playlist, you will have to set those as well. You 
can use View Options from the View menu and turn on the 
Equalizer checkbox to add the Equalizer column which shows 
a pop-up menu and then the current preset name. You cannot 
change multiple songs with the pop-up though. To make the 
change to everything currently in a playlist, highlight that play-

Bradley’s Tech Session
Bradley Dichter
Technical Advisor 
bdichter@optonline.net

Bill Medlow
President
archbill@optonline.net

January Meeting continued from Page 1

One of the great things about LIMac is that 
we are 25 years in themaking, and in those 25 
years, our group has progressed from the Mac 
Plus days of small files viewed on black & white 

screens to very sophisticated files on sophisticated equipment. 
With the iPhone, Apple is showing us the future with an sim-
plified OS X operating system running hundreds of small and 
creative applications besides the cell phone itself. Who knows 
where we will be in the next ten years? It will be fun to see.

The one thing that I am certain of, is that we are here, we are 
learning, we are helping one another and having fun.
This February, we will see a very special presentation on pod-
casting. This is another way that the Mac is helping us create 
copies of presentations for distribution and posterity. 0

January  Meeting
Domenico’s Restaurant of Levittown. 6:30 PM 

SW corner King Kullen Shopping Center 
at Hempstead Turnpike and Jerusalem Ave.

http://www.domenicosrestaurant.net/
pages/11alhome.html

January Meeting continued on Page 7
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list on the leftmost column to avoid selecting your entire Music 
collection, then choose Select All from the Edit menu or type 
Command-A and then choose Get Info from the File menu 
or type command-I. You’ll get a dialog boxing asking if you 

“Are you sure you want to edit information for multiple items?” 
Check the box for “Do not ask me again” and click the Yes 
button. Then you’ll get the Multiple Item Information dialog 
box with four tabs at the top. Click on the last “Options” and 
then choose a Equalizer Preset. That will automatically check 
the associated checkbox. Then click the OK button to change 
all the songs. If in the future you add more songs to this play-
list, the visible Equalizer column should make it easy to spot 
the new ones with nothing in that row, so you can change 
it from the pop-up or do another multiple change. You may 
notice in the Info tab of the Multiple Item Information dialog 
box, you can also fix the Genre. By the way, if you are making 
a custom preset, after adjusting the various frequency sliders, 
decrease the preamp slider by an amount equal to the highest 
slider to avoid clipping. Then you can save the preset. You will 
probably have to increase the general volume to compensate for 
an aggressive setting.
| Is Mac OS 10.5.6 a computer download? We just bought 
Leopard from the Apple Store and it was 10.5.4. Should they 
have sold us 10.5.6?
■ It is a free download in two forms most people may want, the 
other two are for the server version of the Mac OS. There is the 
small delta update from Mac OS 10.5.5 and a combo update from 
any Mac OS 10.5 from 10.5.0, 10.5.1, 10.5.2 through 10.5.5. If 
your computer is still running something older than 10.5.0, then 
the 10.5.6 Combo updater will not upgrade from say Mac OS 
10.4. You would have to purchase for $129 list price, the retail ver-
sion of Mac OS 10.5. The currently shipping Leopard DVD has 
in fact version 10.5.4, so you would presumably first run Software 
Update to get all the updates since that, which would include the 
10.5.6 Combo Update and a bunch of other updates since that. 
Remember that the Mac OS 10.5.4 disc does not include iLife 
nor iWork. They are sold separately, but Apple will be shipping 
at the end of January the Mac Box Set for $169 which bundles 
iWork ‘09, iLife ‘09 and Leopard. If you can hold out a few weeks 
without Leopard, then you might consider returning, if unopened, 
the Leopard and upgrade to the Box Set.

Bradley’s Tech Session continued from Page 2

Bradley’s Tech Session

| My 2 year old 17” MacBook Pro with USB modem fails 
to receive faxes, even manually, after it wakes up? I have to 
restart to get it to work. Is there a way to just reset the fax 
software? How can I fix this situation?
■ Don’t let the Mac go to sleep or restart if you must. You are 
not the only ones with this. Apple has not cared to maintain the 
quality of their fax software as Steve thinks most people don’t 
use it anymore. The problems got worse after the Mac OS 
10.5.2 update. You could try PageSender software, $40 from 
SmileOnMyMac instead of Apple’s. Here is what I did: Give up 
and buy a real plain paper fax machine you leave on 24/7. You 
might consider a all-in-one printer/copier/scanner/fax. You 
can still use the USB modem for outgoing faxing, but HP’s 
software allows you to fax out of the machine from the Mac, 
so you don’t need even the modem. If you check out the HP 
Officejet J4680, it works wirelessly, which is great for laptops 
like the MacBookPro. It costs just a bit more than a decent fax 
machine at $120 which admittedly is more than the $49 for the 
USB modem but offers so much more. Maybe the Apple USB 
modem could be employed when on the road.
| I have a problem where my 3 to 4 year old Canon printer is 
printing a black only line drawing with a purple cast. Is that a 
common problem?
■ This commonly happens when one kind of ink bleeds over 
the print heads for another color. It can also be caused by the 
black ink print heads being clogged and the printer uses deep 
black which includes some color, which now is more obvious 
without the black component. It happens over time and thus 
gets progressively worse. Try a deep cleaning cycle or two. A 
test print could also show the yellow ink not working and thus 
the balance of the color would come out purple. If your printer 
model uses replaceable print heads, then it may be time to 
replace them.
| I’ve put in CDs into iTunes, but what can I do to bring in 
the sound track from a DVD? Can I use MacTheRipper?
■ I just did that with iSkysoft’s $25 DVD Audio Ripper. See 
http://www.iskysoft.com/dvd-audioripper-mac.html It works 
fast. I had to increase the gain to get half decent audio levels 
and then used Sound Studio to normalize the peak audio 
levels to maximize the signal to noise ratio. You could also use 

Bradley’s Tech Session continued on Page  4
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Steve Jobs Takes Medical  
Leave Until June
by Glenn Fleishman 

Steve Jobs is taking a medical leave of absence from 
Apple until June 2009, while staying involved in “major 
strategic decisions,” according to a letter sent to company 
employees, posted on Apple’s Web site, and distributed as a 
media advisory. “During the past week,” Jobs writes,  
“I have learned that my health-related issues are more 
complex than I originally thought.” Chief Operating Officer 
Tim Cook, often cited as a likely successor to Jobs, will 
handle day-to-day company operations.

How did Jobs go from recovering from a cold a few 
months ago to “complex” medical problems necessitating 
five months off today? It’s been gradual.

First, despite his significant weight loss, Apple said 
that Jobs was “hit with a ‘common bug.’” I, like many 
others, dismissed speculation, because - myself a former 
cancer sufferer - I thought the issue personal unless it 
affected his performance in the role. If it were to affect his 
performance and he wasn’t being factual, he and the com-
pany’s board would face questions and possibly lawsuits 
about disclosure of his health-related issues.

Then, just before Macworld Expo 2009, Jobs released a 
public statement saying that he was suffering from an 
unknown malady, which was diagnosed as a hormone 
imbalance. (See “Jobs Clears the Air on Health Issue,” 
2009-01-05.) No one knew precisely what was wrong, as his 
description was specific but lacked a condition name, but 
the board offered their support for his leadership.

Now, the problem is more “complex,” still undisclosed, 
and apparently likely to take him months to recover from. 
Bloggers and mainstream media columnists alike have been 
speculating that Jobs has had a recurrence of the pancreatic 
cancer for which he was operated on in 2004, or that a new 
and serious health condition would force him to step down.

A lot of us who follow Apple have been saying, quite 
honestly, “Shut up.” I and most of the Mac journalists  
I know don’t see Jobs as the avatar of all that is right and 
good at Apple, but instead an effective leader who has 
made largely terrific decisions that thousands upon thou-
sands of employees have executed well. Jason Snell excel-
lently countered the broad media trend of turning Jobs into 
Apple’s godhead in an interview with Ad Age.

Listen: We at TidBITS will all be sad if Jobs has a chroni-
cally debilitating or fatal illness. We’ll find it a dark day 
when he takes off the mantle for good as Apple’s chief. But 
the company doesn’t rise and fall by him.
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Rogue Amoeba’s $32 Audio Hijack Pro or the like to capture 
the audio from the DVD in real-time. Of course they would 
suggest Fission to edit the file. Likewise there is Ambrosia 
WireTap Studio. MacTheRipper can use Chapter Extraction 
mode with “demux streams” enabled, only audio tracks enabled 
(ac3, dts, and pcm, not m2v or subtitles) and “merge chap-
ters” disabled. That should generate a AC3 file which the old 
mac3dec version 1.6.3 can convert to a MP3, AAC or AIFF 
format file which can then be used in iTunes. Download at 
http://downloads.sourceforge.net/mac3dec/mac3dec1.6.3.sit.
hqx?modtime=1093478400&big_mirror=0 If you can’t get a 
AC3 file, but a PCM file then use the free AIFF from PCM 
to generate a uncompressed AIFF format file. Download 
at http://www.verek.com/products/aiff_from_pcm/beta/
AIFFfromPCM_1.0b12.dmg

| The human resources department at my job uses a intranet 
website for information which requires Internet Explorer 
under Windows. So now I have to put Windows onto my 
machine. How much does a copy cost? I’ve seen around $200. 
I have an Intel based iMac.
■ You don’t have to buy the boxed retail version. The basic 
OEM version should be just fine, as you get a CD and a serial 
number. A quick search on the internet found a legit (full, not 
upgrade) copy (with COA or Certificate of Authenticity) of 
Windows XP Pro SP2 for $48 with shipping. http://www.google.
com/products?q=windows+XP+Pro+SP2+COA&hl=en&show=dd
&scoring=p&lnk=pruser&price1=47&price2=51&btnP=Go.You 
can use this with Boot Camp for no additional money if you are 
running Leopard or with VMware Fusion 2 which is $80. 2GB 
of RAM is recommended and can work under Mac OS 10.4.11. 
Of course VMware Fusion is more convenient as you don’t 
have to restart in order to use it.
| Do the USB ports on the 17” MacBook Pro go to sleep 
when the rest of the computer does? My USB powered fan 
continues to work and draw power even when the computer 
is sleeping. The iPod shuffle does not charge when the com-
puter goes to sleep.
■ All three act the same. The shuffle is a smart device and gets 
a command over the USB data channel that the computer is 
about to go to sleep. The cooling pad just taps the power con-

Bradley’s Tech Session continued from Page 3
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Jobs has recruited and forged a large team of execu-
tives, engineers, and marketers who understand how to 
make products people want. Decisions from Apple don’t all 
originate at the top, despite the way the company is com-
monly portrayed. We hear from past and present Apple 
employees that many of Apple’s best decisions were made 
lower down, and then approved at the top.

The culture that makes Apple work has been distributed 
throughout the firm. That’s probably Jobs’s most effective 
legacy.

We wish Steve Jobs a swift and complete recovery. And 
we expect Apple to tick along just as usual.

Protect Yourself From the 
Safari RSS Vulnerability
by Rich Mogull 

Programmer Brian Mastenbrook revealed on January 
11th that he discovered a security vulnerability in Safari 
that could allow a malicious Web site you visit using Safari 
to read any file on your system. The flaw affects the latest 
versions of Safari when used in Mac OS X 10.5 Leopard or 
Windows. Mastenbrook wrote that he has reported the 
details to Apple.

The vulnerability apparently could reveal any file, which 
includes emails, passwords stored in browser cookies, or 
other documents. We have strong indications that the 
problem is real and you should immediately protect your-
self in case malicious attackers figure out the vulnerabili-
ty’s full details before Apple issues a patch.

The vulnerability is in the Safari RSS reader, and 
according to Mastenbrook, you may be affected even if you 
don’t use the reader as long as Safari is set to be your 
default RSS reader; if you use Safari without ever having 
changed this setting, then Safari is your RSS reader. This 
likely indicates that the problem relates to how the Web 
browser handles RSS subscription links or feeds, since 
those will trigger the RSS reader if you browse them using 
Safari.

The good news is that it’s very easy to protect yourself. 
If you are on Windows, just stop using Safari until a fix is 
released. If you are using OS X 10.5 Leopard, make sure 
Safari isn’t your default RSS reader. In Safari, select Safari 
> Preferences and click the RSS tab. From the Default RSS 
Reader pop-up menu, change the application to anything 
other than Safari. If you are using OS X 10.4 Tiger or earlier 
this problem doesn’t affect you.

It’s always a relief when there is an easy workaround to 
a potentially serious security vulnerability, and we won’t 
be surprised if Apple gets this one patched fairly quickly. 0

“Photoshop CS4: The Missing Manual” 
by LIMac’s good friend, Lesa Snider King is 

now available. Packed with 896 pages of tips, tricks, and lots of 
practical advice, this new Missing Manual teaches 
you everything you need to know to edit photos 
and create beautiful documents in Photoshop 
-- whether you’re a beginner or a power user 
ready to try some advanced techniques. This 
user group member price is $29.99, com-
pared to the regular price of $49.99. Learn 
about the latest in CS4: http://oreilly.com/

catalog/9780596522964/?CMP=ILC-MMh0me Online 
Code: This offer is valid through March 31, 2009.

“Welcome to Macintosh - The documentary for the rest 
of us.” is the first movie of its kind to explore the many ways 
Apple Inc. has changed the world. Topics include Apple’s his-
tory, innovations, and community. The DVD is NTSC Region 
FREE (ALL). You pay only $15.99, compared to the retail 
price of $19.84. Welcome to Macintosh is an independent 
motion picture, and has not been authorized, sponsored, or 
otherwise approved by Apple Inc. See it now: http://www.wel-
cometomacintosh.com Coupon Code:  This offer 
is valid through March 31, 2009.

Introducing iStudio Publisher, the exciting new page layout 
program for home, small business and educational users. 

Powerful and intuitive, it lets you do everything 
from producing a flyer to designing a newsletter 
-- from creating a brochure to publishing a 
magazine. iStudio Publisher gives you all the 
tools you need within easy reach to design 
great looking documents. This user group 
special offer price is $44.99 compared to the 

discounted launch price of $49.99 (only available until 
March 5) and the regular price of $99.99. Purchase here: http://
www.istudiopublisher.com/index.php/store/ Promotion code: 

George Canellis
User Group Ambassador & Vice President
gwc11713@optonline.net
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http://www.google.com/products?q=windows+XP+Pro+SP2+COA&hl=en&show=dd&scoring=p&lnk=pruser&price1=47&price2=51&btnP=Go
http://www.google.com/products?q=windows+XP+Pro+SP2+COA&hl=en&show=dd&scoring=p&lnk=pruser&price1=47&price2=51&btnP=Go
http://oreilly.com/catalog/9780596522964/?CMP=ILC-MMh0me
http://www.welcometomacintosh.com
http://www.istudiopublisher.com/index.php/store/
http://www.istudiopublisher.com/index.php/store/
mailto:gwc11713@optonline.net
http://www.rogueamoeba.com/audiohijackpro/
http://www.rogueamoeba.com/fission/
http://www.ambrosiasw.com/utilities/wiretap/
http://www.mactheripper.org/
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nections and will continue to run and drain the Mac’s battery. 
MacBooks don’t have the problem. It may be fixable with a 
future operating system update. Until then the only option is to 
pull the USB power cable before putting it to sleep unless there 
is a power switch.
| Does the iPhone support multitasking?
■ The iPhone’s OS X operating system is in fact multi-tasking 
so you can be reading a web page while new email arrives 
either via WiFi or EDGE or 3G. The problem is Apple keeps 
the multitasking goodness for their own applications like Safari 
and Mail. It is spelled out in the iPhone Human Interface 
Guidelines. Of course there is little purpose in a game which 
is going to make noises running at the same time as iTunes 
playing a song. You know that iTunes is paused when a phone 
call comes in. In fact the music fades out rather than abruptly 
stopping before the ringtone starts. Maybe a future iPhone 
with a multi-core processor could be allowed to support 3rd 
party apps to multitask.
| What are the best printable DVD-R you can buy? Which ones 
should I stay away from? MicroCenter’s house brand, TDK?
■ Generally I buy Verbatim brand disc and they are high 
quality to storing data and quite acceptable for actually printing 
on. They have White or Silver in standard and hub-printable 
and Glossy White in standard form. Even longer lasting are the 
MAM-A brand DVD-R which are available in silver (clear actu-
ally) hub printable or white standard styles. They also have 
Double Layer DVD+R DL white in standard and hub-print-
able. Their Gold Archival DVD-R are not inkjet printable but 
they do have Gold Archival DVD+R in white inkjet printable. 
These gold discs will last the longest of all. Stay far away from 
Memorex. MicroCenter’s own label is not good, but maybe 
slightly better than Memorex, TDK is good, not as good as 
Verbatim. They tend to be rated at slower burn speeds. I’ve 
tried printing on them but got worse results than the Verbatim.
| I see they came out with the record player with USB but I 
already have a turntable. What would be the method for con-
verting my LPs into a CD? I have a MacBook Pro.
■ Since your Mac has a audio input, then it’s fairly easy. Just 
leave your turntable hooked up to your receiver, and take a 
line level output, say a tape out pair of RCA jacks, go to Radio 
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This offer is valid through August 31, 2009.

“Advanced Twitter for Business: Conversation, Community 
and Profit - 140 Characters at a Time” will be featured as a Live 
Webcast on February 6 at 10:00 am PST. If you’re ready to go 

beyond dabbling with Twitter, join the experts at 
O’Reilly for this live webcast presented by Sarah 
Milstein. Learn everything you need to launch 
a successful Twitter strategy for your business. 
You’ll learn how to use Twitter to promote your 
business, build community, find employees and 
research the market and your competition. The 

regular price is $99, but this user group discount code offer 
will get you 35% off. Register and learn new business strategies: 
http://oreilly.com/go/advancedtwitter Discount code: This 
offer is valid through February 6, 2009.

MacPadd is a high-end mouse pad made of solid aluminum 
to provide superior mouse-to-screen tracking performance. 
Outstanding features of MacPadd include an antibacterial sur-
face and reduced wrist fatigue with its ultra-smooth surface. 
MacPadd has an elegant luster to compliment the iMac and 
MacBook Pro, is extremely durable, acts as a shield in your 
laptop bag during travel, offers a reduced carbon footprint and 

recyclable construction, improved user/com-
puter interface, industrial strength, easy to 
clean materials and a great price. Everyone will 
admire your great taste in computer acces-
sories. Apple user group members are being 

offered a limited-time price of $21.25 on MacPadd, 
which is regularly priced at $24.99. Compliment your mouse: 
http://www.macpadd.com Coupon Code: This 
offer is valid through March 31, 2009.

“Digital Video Essentials: Apple Final Cut Pro 6” offers a 
concise, step-by-step guide to video editing. Relevant to both 
novice and professional, this comprehensive resource covers 
the important features that editors need to get the job done 
quickly. Rysinger uses a straight-forward approach and full-
color visuals to guide editors through the software’s features. 
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http://oreilly.com/go/advancedtwitter
http://www.macpadd.com
http://developer.apple.com/iphone/
http://www.microcenter.com/single_product_results.phtml?product_id=0262485
http://www.mediamegamall.com/mitsui-mama-gold-dvdr-47gb-branded-50pk-spindle-83438-p-5459.html
http://www.mam-a.com/products/dvd_product_list.htm
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Shack and buy a 1/8 inch stereo phone plug to a pair of 
RCA plugs, a 6 footer like their catalog number 42-2551 
for $9 should do nicely. Then use the System Preferences 
to switch your audio input and then you need some soft-
ware to capture the audio input. There are plenty of choices. 
There is the free Final Vinyl 2.5.1 from Griffin Technologies. 
Roxio Toast Titanium comes with CD Spin Doctor which 
can do the job. The recently introduce Toast 10 Pro $130 
includes BIAS SoundSoap SE 2 for cleaning up the recording. 
It has specific and automatic click, crackle and 60Hz hum 
removal. The previously mentioned Rogue Amoeba Fission 
is $32. There is also Amadeus Pro, $40. I’m partial to Sound 
Studio from Freeverse, perhaps out of habit as I’ve used it 
for years and it’s easy to understand. You could also cap-
ture with GarageBand, but it’s not easy to normalize or 
edit. If you have a more professional setup, then you may 
have Apple’s Logic Express which of course can record and 
edit, but this is a $200 program and perhaps overkill for this 
purpose. There is a $219 bundle of BIAS Peak 6 LE and 
SoundSoap 2. If you want to get serious about audio resto-
rations, there is the Bias SoundSoap Pro, but that is $599. 
Generally you will want to clean up the sound from clicks 
and cut up the whole album side recording into separate 
files for each of the tracks. Then either import into iTunes 
or drop the files (preferably uncompressed AIFF files) into 
Toast and burn a CD. Not that you can’t do both. I guess 
I should also mention for those not willing to include the 
receiver in the equation, particularly those without a por-
table Mac or those older PowerMac G4 lacking a audio 
input, there is a inexpensive option, the new $50 Griffin 
iMic which includes a pre-amp for the turntable. This con-
nects via a USB connection to the Mac. Minus the pre-amp, 
it can also accommodate the line level output from a 8-track 
or reel-to-reel or compact cassette tape player. You can also 
plug in a 1/8 inch microphone and record yourself singing 
or playing an instrument. If your music playing is more 
serious and you have XLR style or 1/4 inch microphones, 
then there are compact pre-amps like the USB Dual Pre 
from ART for about $81 that should do nicely for a home 
recordist. http://www.provideosound.com/art-usbdualpre.
html . 0

Bradley’s Tech Session continued from Page 5

This book also features Noise Industries’ FxFactory Pro and 
includes a DVD packed with valuable features. With a regular 
price of $46.95, this exclusive user group price is $35.21. 
Learn more: http://www.delmarlearning.com Buy today: http://
tinyurl.com/578o2h Promotional Code: This 
offer is valid through March 31, 2009.

Give your arm a break with the IN YOUR FACE viewbase 
which makes on-the-go movie watching fun and easy. Just 
download a movie to your iPhone or iPod touch and watch it 
hands-free and up close. This innovative holder features a flex-
ible neck, easy secure top grip with quick release, adjustable 
swivel head, non-scratch gripping pads and hinged bottom 
clamp for flat or round surfaces. With a regular 

price of $29.95, this exclusive user group 
price is $19.95. Offer is available: http://
www.inyourfaceusa.com/ Discount Code: 

This offer is valid through April 
30, 2009.

ThermaPAK’s patented HeatShift Technology is a unique 
blend of phase changing material (PCM) created by research 
and development engineers. It requires no refrigeration, no 
laptop power (which extends battery life), is easy to carry 
(approved for airport security), and performs better than USB 
fan-style products. The HeatShift Laptop bag is made of a high-
density memory foam for strong protection and has a remov-
able HeatShift Pad inside. Ranging in retail price from $27.99 
(13” laptop) to $34.99 (17” laptop), this user group special 
takes 25% off. ThermaPAK’s Laptop Cooling HeatShift Pads 
and HeatShift Bags are also available at a discount. Get your 
cooling pad: http://www.thermapak.com/products.
php Coupon code: This offer is 
valid through April 30, 2009. 0
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http://www.provideosound.com/art-usbdualpre.html
http://www.provideosound.com/art-usbdualpre.html
http://tinyurl.com/578o2h
http://tinyurl.com/578o2h
http://www.inyourfaceusa.com/
http://www.radioshack.com/product/index.jsp?productId=2103865
http://www.griffintechnology.com/software/0000/0007/Final_Vinyl_v2.5.1.dmg
http://www.roxio.com/enu/products/toast/titanium/listen.html
http://www.roxio.com/enu/products/toast/pro/overview.html
http://www.rogueamoeba.com/fission/
http://www.hairersoft.com/AmadeusPro/AmadeusPro.html
http://www.freeverse.com/apps/app/?id=5012
http://www.freeverse.com/apps/app/?id=5012
http://www.apple.com/ilife/garageband/
http://www.apple.com/logicexpress/
http://www.bias-inc.com/products/peakLe6/
http://www.bias-inc.com/products/soundSoap2/
http://www.bias-inc.com/products/soundSoapPro/
http://www.griffintechnology.com/products/imic
http://www.griffintechnology.com/products/imic
http://www.thermapak.com/products.php


7THE LIMAC FORUM/FEBRUARY 2009

■ Table categories: When there are large sets of data in one 
spreadsheet, it can be difficult to make sense of it all. With one 
click, you can now group rows based on data in any column 
and create table categories.
■ Advanced charts: Numbers ’09 features even more impressive 
options for 2D charts.
■ Linked charts: Create charts in Numbers and paste them into 
Pages documents or Keynote presentations.
The last part of the iWork presentation described the fol-
lowing new features included in Keynote:
■ Magic Move: The new Magic Move feature lets you add a 
sophisticated animation using a quick and simple process.
■ Text- and object-based transitions: In just a few clicks, you 
can apply text and object transitions that look as if they were 
created by your own special effects team.
■ 3D charts and chart animations: Now you can add impressive 
charts and animations.

 The new features of both iWork ’09 and iLife ’09 are very 
compelling. Before you think about upgrading, make sure 
your computer meets the system requirements.

 iWork ’09 System Requirements
■ �Mac computer with an Intel, PowerPC G5, or PowerPC G4 

(500MHz or faster) processor
■ 512MB of RAM; 1GB recommended
■ 32MB of video memory
■ Mac OS X v10.4.11 or Mac OS X v10.5.6 or later
■ QuickTime 7.5.5 or later
■ 1.2GB of available disk space
■ DVD drive required for installation

 iLife ’09 System Requirements
 ■ �Mac computer with an Intel, PowerPC G5, or PowerPC G4 

(867MHz or faster) processor
■ �iMovie requires an Intel-based Mac, Power Mac G5 (dual 

2.0GHz or faster), or iMac G5 (1.9GHz or faster).
■ �GarageBand Learn to Play requires an Intel-based Mac with 

a dual-core processor or better.
■ �512MB of RAM; 1GB recommended. High-definition video 

requires at least 1GB of RAM.

■ Approximately 4GB of available disk space
■ DVD drive required for installation
■ Mac OS X v10.5.6 or later
■ QuickTime 7.5.5 or later (included)
■ �AVCHD video requires a Mac with an Intel Core Duo 

processor or better. Visit iMovie ’09 Camcorder

 Lastly, Brad described the new 17" MacBook Pro. He was 
careful to point out the pros and cons of Apple's newest laptop. 
Features are as follows:
■ The longest-lasting Mac notebook battery ever.
The battery in the new 17-inch MacBook Pro lasts up to 8 
hours on a single charge and can be recharged up to 1000 
times compared with only 200 to 300 times for typical note-
books. Brad pointed out the only downside of this as that the 
battery is not user replaceable. However the battery does not 
have to be replaced as often (battery should last between 7 and 
8 years) and the cost of having Apple replace the battery is only 
a bit more than the cost of buying a quality battery.
■ Choice of graphics chips: Use the new NVIDIA GeForce 
9400M integrated graphics processor for great everyday per-
formance with up to 8 hours of battery life. or switch to the 
discrete NVIDIA 9600M GT graphics processor for the fastest, 
smoothest, clearest graphics yet.
■ LED backlit display.
■ Ports in the new portable are as follows: The 17-inch 
MacBook Pro is iPod, iPhone, digital camera, and external hard 
drive ready. If it has a cable, there’s a place for it. You’ll find 
three USB 2.0 ports and a FireWire 800 port for connecting 
faster peripherals. The Mini DisplayPort is a perfect fit for the 
new Apple LED Cinema Display
■ Comes with 4 GB of ram and can be upgraded to 8 GB.
Brad’s presentation included much more detail than I can 
include in this article. You know it's like they say "you had 
to be there".  I really encourage you to attend meetings, you 
will definitely get more information than I can include in my 
articles. Many thanks to Brad for doing his usual great job. If 
you need more information I suggest you check out Apple’s 
website. It includes some great movie clips showing how these 
things work. 0
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January  Meeting

For a Year’s membership
Send your $36 check to: 

 
LI Macintosh Users Group, 

P.O. Box 2048 

Seaford, NY 11783-0180

I

Renewal
Membership renewal for 2009 takes place from 
October onwards. A bonus discount was passed by 
the Board of Directors a few years ago: Bring in a 
new dues-paying member and get a $12 discount 
off your membership renewal.  Bring in three new 
members and your renewal is free!

Bringing in a  new member also includes getting 
a past member back into the group.

Make your $36 check out to LIMac and bring it 
to the next meeting, or mail to LIMac, Post Office 
Box 2048, Seaford NY 11783-0180

How to better visually enjoy the Forum:Your Editor 
prefers you to use Adobe Reader 9 as long as your Mac 
meets the requirement of Mac OS 10.4.11 or newer. 
PostView 1.6.3 works from Mac OS 10.2 all the way up 
to 10.5 for PowerPC and Intel based Macs.  

NOTE
This edition is made for viewing on your computer 
screen, if however, you wish a more printer friendly 
edition without all the colors just email me at 
azygier@nyc.rr.com and I’ll be happy to send you one. 
(Al)

http://www.adobe.com/products/acrobat/readstep2.html?promoid=BUIGO
mailto:azygier@nyc.rr.com?subject=Printer friendly Forum request
http://www.apple.com/iwork/numbers/#categories
http://www.apple.com/iwork/numbers/#chart
http://www.apple.com/iwork/keynote/
http://www.apple.com/iwork/keynote/#magic
http://www.apple.com/iwork/keynote/#transitions
http://www.apple.com/iwork/keynote/#charts
http://www.apple.com/iwork/systemrequirements.html
http://www.apple.com/ilife/systemrequirements.html
http://www.apple.com/macbookpro/features-17inch.html
http://www.apple.com/macbookpro/17inch-battery/
http://www.apple.com/macbookpro/graphics.html
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